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1. Installation and Registration
1.1 Installation on Windows

The start screen for the installation will normally be automatically displayed. If the auto-
start function of your CD/ DVD drive is deactivated, open the start screen manually by
going to My Computer, double clicking on the CD/DVD drive symbol and then
Starter.exe or Starter.
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Once you are at the CD start screen, choose your language and then click on Install
DENOISE projects professional.

Setup-Sprache auswidhlen

| ‘Wahlen Sie die Sprache aus, die wahrend der
| i!#_-' Installakion benukzt werden soll:

Deutsch

[ o4 J [ Abbrechen

Choose German, English or French as setup language and follow the installation
assistant’s instructions.



1.2 Installation on Mac

Load your CD into your CD/DVD drive and open the installation menu through the
desktop. Drag the DENOISE projects professional file into the program link. To use
the Adobe® Photoshop plug-ins, open the Adobe® Photoshop plug-ins folder and copy
the appropriate plug-ins into your Photoshop plug-ins folder. You can now use DENOISE
projects professional to edit your photos!

1.3 Installation of Adobe Photoshop®© Plug-ins

During the installation, you will be asked if you would like to install the Adobe®
Photoshop plug-in.

If you agree to this, you can use DENOISE projects professional as a plug-in for
Adobe® Photoshop. Alternatively, the plug-ins can also be manually copied into the
Adobe® Photoshop plug-in folder. Select the plug-in entry folder in the CD start menu to
open it.

Additionally, the latest plug-ins for your software are available at:
http://www.projects-software.com/plugins



http://www.projects-software.com/plugins

1.3.1 Windows 32 Bit Operating Systems

1. Complete the installation of DENOISE projects professional by activating the
software.

2. For some reasons it may occur that plug-ins cannot be installed automatically in all
Adobe Photoshop®© versions. They have to be copied into the plug-ins folder of
Adobe Photoshop© manually.

3. Please close Adobe Photoshop®© as well as the stand-alone version of DENOISE
projects professional.

4. Open the installation package folder of DENOISE projects professional. Here,
you will find the plug-ins for all versions of Adobe applications that are supported.

Start Freigeben Ansicht ~ @

@ = T . <« Den.. » WIN DENOISE projects profes... » v O "WIN DEMQISE projects profe.. @

-

Mame Anderungsdaturm Typ Grofe

. Photoshop CC 2074 Plugin 30.09.201512:42 Dateiordner
J Photoshop CC 2015 Plugin 30.09.201512:42 Dateiordner
. Photoshop CC Plugin 30.09.2015 12:42 Dateiordner
. Photoshop C56 Plugin I 30.09.201512:42 Dateiordner
| Photoshop Elements 11 Plugin 30.09.201512:42 Dateiordner
. Photoshop Elements 12 Plugin 30.09.201512:42 Dateiordner
.. Photoshop Elements 13 Plugin 30.09.2015 12:42 Dateiordner
| Photoshop Elements 14 Plugin 30.09.2015 12:42 Dateiordner

DEMOISE projects professional DE_EMN_FR. Setup.exe  30.09.2015 12:40 Anwendung

<

9 Elemente

9 Elemente (Freier Speicherplatz: 824 GB) 71,8 MB 1M Computer

5. Open the plug-in folder of your Adobe application (in this instruction the installation
of the plug-in will be demonstrated for Adobe Photoshop© CS6).

nien-|
Start Freigeben Ansicht ~ @

@ * 1 . » WINDEN.. » Photoshop C56 Plugin "Photoshop C56 Plugin® dur., 0

Marne Anderungsdaturm Grafie

iﬂ DEMOISEProjectsProfessional_PHE x64.8be  23.06.2015 22:58 BBE-Datei 822 KB
“ﬂ DEMOISEProjectsProfessional PHE x26.8be  23.06.2015 22:58 ABE-Datei 671 KE|

2 Elemente 1 Element ausgewshlt (671 KB)
Typ: 8BE-Datei, GroBe: 671 KB, Anderungsdaturm: 23.06.2015 22:58 671 KB 1M Computer




6. Copy the file DENOISEProjectsProfessional PH6_x86.8be from installation
package and paste it into the plug-ins folder of Adobe Photoshop© CS6 that you will
find here:

C:\Program Files\Adobe\Adobe Photoshop CS6\Plug-ins

RiED-
Datei Start Freigeben Ansicht ~ 0
@ * T . « Adobe » AdobePhotoshopC56 » Plug-ins v & "Plug-ins" durchsuchen P
MName h Anderungsdatum Typ GraBe i
. Athentech 16.06.2015 14:25 Dateiordner
| Generator 16.06.2015 16:29 Dateiordner
| Panels 06.03.2015 1317 Dateiordner
|ﬂ AMNALOGProjects_PHT_x86.8be 17.02.2014 1%:04 8BE-Datei 821 KB
|ﬂ AMALOGProjects3_PH7 x86.8be 11.02.2015 22:34 BBE-Datei 821 KB
|ﬂ BLACKWHITEProjects3_PH7_x86.8be 22.05.2014 15:39 BBE-Datei 821 KB
|ﬂ BLACKWHITEProjectsd PH7 x86.8be 23.06.2015 23:01 2BE-Datei 822 KB
|ﬂ Coloriage_x36.8be 24,01.2014 10:27 8BF-Datei 1.252 KB
|2 COLORProjects4_PHT x86.8be 23.06.2015 23:01 8BE-Datei 645 KB
E.hmwﬁn liitish 22.01.201517:11 8BE-Datei 821 KB
= DENOISEProjectsProfessional_PH7_x86.8be 17.11.2014 17212 8BF-Datei 578 KB
e bebsonions ety el 17.11.2014 1712 8BE-Datei 822 KB
|ﬂ Draw_xB6.8be 21.03.2014 16:28 SBE-Datei 822 KB
8BE-Datei 645 KB
dBE-Late b4 Kb ~
36 Elemente  Status: 3B Freigegeben =] =
56 Elemente (Freier Speicherplatz: 78,1 GB) 40,3 MB Lol Computer

7. Restart your Photoshop application and open an image.

8. Navigate to File = Export - DENOISE projects professional... .
One click will start the plug-in. The image will now be opened in DENOISE
projects professional.
The plug-in will not be in the Filter menu.



Filter
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1.3.2 Windows 64 Bit Operating Systems

1. Complete the installation of DENOISE projects professional by activating the
software.

2. For some reasons it may occur that plug-ins cannot be installed automatically in all
Adobe Photoshop®© versions. They have to be copied into the plug-ins folder of
Adobe Photoshop© manually.

3. Please close Adobe Photoshop®© as well as the stand-alone version of DENOISE
projects professional.

4. Open the installation package folder of DENOISE projects professional. Here,
you will find the plug-ins for all versions of Adobe applications that are supported.

Start Freigeben Ansicht ~ @

T )« Den.. » WIN DEMNOISE projects profes... » v & "WIN DEMOISE projects profe.. @

A

Mame Anderungsdaturm Typ GroBe

. Photoshop CC 2015 Plugin I 30.09.2015 12:42 Dateiordner

| Photoshop CC Plugin 30.09.2015 12:42 Dateiordner

I | Photoshop CC 2014 Plugin 30.09.2015 12:42 Dateiordner

| Photoshop C56 Plugin 30.09.2015 12:42 Dateiordner
| Photoshop Elements 11 Plugin 30.09.2015 12:42 Dateiordner
30.00

| Photoshop Elements 12 Plugin 30.09.2015 12:42 Dateiordner
| Photoshop Elements 13 Plugin 30.09.2015 12:42 Dateiordner
| Photoshop Elements 14 Plugin 30.00.2015 12:42 Dateiordner

@ DEMQISE projects professional DE_EN_FR Setup.exe  30.08.20153 12:40 Anwendung

<

9 Elemente

9 Elemente (Freier Speicherplatz: 824 GEB) Lol Computer

5. Open the plug-in folder of your Adobe application (in this instruction the installation
of the plug-in will be demonstrated for Adobe Photoshop© CC 2015).

6. Copy the file DENOISEProjectsProfessional PH7_x64.8be from the installation
package and paste it into the plug-ins folder of Adobe Photoshop© CC 2015 that
you will find here:

C:\Program Files\Adobe\Adobe Photoshop CC 2015\Plug-ins



Start Freigebien Ansicht

© = 4 | « Adobe » AdobePhotoshop CC2015 » Plug-ins
MName 2 Anderungsdatumn
. Athentech 16.06.2015 14:25
| Generator 16.06.2015 16:29
1 Panels 06.03.2015 13:17
. Redfield 07.09.2015 12:45
(&) ANALOGProjects_ PHT x64.8be 17.02.2014 19:04
(=] ANALOGProjects3_PH7_x64.8be 11.02.2015 22:34
(&) BLACKWHITEProjects3_PH7 x64.8be 22.03.2014 15:39

Iﬂ BLACKWHITEProjectsd_PHT_x64.8be
|+ BWStyler208Demo_tdbit.8bf
E Coloriage_64.8be
Iﬂ COLORProjectsd_PHT_x64.8be
1 £AL CH

= | DEMOISEProjectsProfessional_PH7 _x64.8be

T T VOSSRt o SUURN PUPOUIN TN e - 4

E Draw_g4.8be

56 Elemente  Status: 33 Freigegeben
56 Elernente (Freier Speicherplatz: 78,1 GE)

23.06.20153 23:01
2201.2015 1711
24.01.2014 10:27
23.06.2013 23:01
22.01.2015 1711
17.11.2014 17212
17.11.2014 1712
21.03.2014 16:28

L

Typ

Dateiordner
Dateiordner
Dateiordner
Dateiordner
SBE-Datei
8BE-Datei
8BE-Datei
8BE-Datei
8BF-Datei
SBE-Datei
8BE-Datei
8BF-Datei
SBE-Datei
8BE-Datei
SBE-Datei

40,3 MB

¢

"Plug-ins" durchsuchen

GraBe

221 KB
821 KB
821 KB
822 KB
1.252 KB
6435 KB
821 KB
578 KB
822 KB
822 KB
6435 KB

il Computer

7. Restart your Photoshop application and open an image.

8. Navigate to File = Export - DENOISE projects professional... .

One click will start the plug-in. The image will now be opened in DENOISE

projects professional.

The plug-in will not be in the Filter menu.
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1.3.3 MAC OS X Operating Systems

1. Complete the installation of DENOISE projects professional by activating the
software.

2. Open the installation package folder of DENOISE projects professional. Here,
you will find the plug-ins for all versions of Adobe applications that are supported.

3. Please close Adobe Photoshop®© as well as the stand-alone version of DENOISE
projects professional.

4. Additionally, the latest plug-ins for your software are available at:
http://www.projects-software.com/plugins

@ & 9 MAC DEMNOISE projects professional_DE_EN_FR
oy
= 00 ol o v I~ Q. Suchen 7
Favoriten
Q Dropbox
£ Alle meine Dateien DENOISE projects Photoshop CC 2014 Photoshop CC 2015
¢2 iCloud Drive professional Plugins Plugins
@ AirDrop
[l Schreibtisch
@ Lektorat Photoshop CC Plugins Photoshop CS6 Plugins Photoshop E_Iements 11
Plugins
;ﬂ\; Programme
@ Dokumente
B3 akvis Photoshop Elements 12 Photoshop Elements 13 Photoshop Elements 14
Plugins Plugins Plugins

5. Open the plug-in folder of your Adobe application (in this instruction the installation
of the plug-in will be demonstrated for Adobe Photoshop© CC 2015).

® ® "9 Photoshop CC 2015 Plugins

< Hll = [0 ol 5% v 2 - vs
Fawvoriten -

25 Dropbox

& Alle meine Dateien DENOISEProjectsProfessio

¢ iCloud Drive nal_PH7.plugin

@ AirDrop

= Schreibtisch

@ Lektorat

&' F-'roi ramine
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http://www.projects-software.com/plugins

6. Copy the file DENOISEProjectsProfessional PH7.plugin from the installation
package and paste it into the plug-ins folder of Adobe Photoshop© CC 2015 that
you will find here:

Applications/Adobe Photoshop CC 2015/plug-ins

eo0e [ Plug-ins
< AE - ENERIEE=) © | #- Q £
Favoriten [,.‘ HDR projects 3 Alias Adobe Phot...einstallieren
3 Dot & Photo BUZZER Alias [0 Beispiele > = a
P& PhotoZoom...ssic 6 Alias 1 Configuration > ;ﬂ iCorrect Por...it 2.0.plugin
@ Alle meine Dateien ,‘E PhotaZoom Pro 6 Alias B9 Legal > ;ﬂ inCamera 4.5.plugin
P . @ Mac Blu-ray Player [ Locales » ] piccure.plugin
0 Cloud Drive = piombino_ultimate.jpg i ﬂ Topaz_adjust5.plugin
@ AirDrop [0 Adobe » B [ Plug-ins vl =] Topaz_BW2..fects.plugin
ﬁ Schreibtisch Bl Adobe Bridge CS5 > (- > [ Piccure+ >
[l Adobe Bridge CS5.1 » [ Scripting » [ 3D Engines »
{2} Lekiorat Adobe Creative Cloud » [ Skript-Dokumente » [@ ADM 2
?A‘: Programme El Adobe Devi..Central CS5 » a LegalNotices.pdf 9 Alien Skin >
[ Adobe Dreamweaver CS5 » = Phetoshop..tte lesen.pdf [ Automate > P LU G_I N
@ Dokumente E Adobe Exte..anager CS5 » PhotoZoom Pro 6.plugin 8 Cut Qut L4 _
B akvis [l Adobe Exte..nager CS5.5 » Adobe Photoshop CS5 |19 Digimare 4
Ed Adobe Fireworks CS5 > d) AKVIS Refocus Plugin W Effects >
Adobe Flas..atalyst S5 » 19 Extensions 4
Adobe Flash CS5 » [ File Formats » \
Ell Adobe lllustrator CS5 [ |59 Filters [ DENOISEProjectsProfess
Bl Adobe InDesign CS5 » 9 Google > ional_PH7.plugin
ﬂ Adcbe InDesign CS5.5 > 7] Image Stacks >
Adobe Medi..ncoder CS5 » [ Import-Export » 17.11.2014, 17:29
- [ Measurements » 17.11.2014, 17:29
B8 Adobe PhotoshopCC 2015 » B Panels . 1z1.204, 17:29
T e = PhotoZoom Pro 4.plugin Tags hinzuflgen ...
|7 Alien Skin > PhotoZoom Pro 6.plugin
[ ArcSoft Connect Suite  » & AKVIS ArtSuite Plugin

7. Restart your Photoshop application and open an image
8. Navigate to File > Export > DENOISE projects professional... . One click will

start the plug-in. The image will now be opened in DENOISE projects
professional. You won’t find it as another filter.

12
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1.3.4 Adobe Lightroom Interface with DENOISE projects professional

Windows Operating Systems

|

. Open Adobe Lightroom.

. Open Edit/Preferences/External Editing/ZAdditional External Editor.
3. In Additional External Editor choose the application DENOISE projects
professional.exe

N

| General | Presets | External Editing | File Handling | Interface | Lightroom mobile |

Edit in Adobe Photoshop CC 2015

Hle Eormal: | TIFE &-bit files are smaller and more compatible with various programs and
: phug-ins, bt will not presarve fine tonal detail 2s well a5 16-bit data,

The sRGE color space cannot encompass the full range of colors

. |SRGB availzble within Lightroom,

Color Space

Bit Depth: |B bitsfcomponent

Resolution:

Compression:

Additionzl Externzl Editor

Preset: |Custom

Application: DEMOISE projects professional.exe

File Format: | JPEG w | JPEG files support anby 5-bit, &-bit files are smaller and more compatible

with variows programs and phag-ins, but will not preserve fine tonal
detail 25 well a5 ].'E-—I:rrtda‘ta Thﬁﬁ(?ﬂ:fﬂhspaﬂecanmtermmaﬁﬁ
Color Space: | <R CR i | the full range of colors available within Lightroom.

Bit Depth: |B bitsfcomponent vl

Resolution: | 300 |

Stack With Original
Stack With Original

Edit Externally File Maming: IMG_0002-Bearbeitet. psd

Template: |Custom Settings

Zustomn Texk: Start Mumber:

Restart Lightroom

14



4. Click OK.
5. Right-click on a picture in Adobe Lightroom.
6. Choose Edit In > Edit in DENOISE projects professional.exe...

Settings k
Lock to Second Menitor

Show in Explorer
Go to Folder in Library

Go to Collection k

Edit In » Edit in Adobe Photoshop CC 2015...

Set Flag g Edit in DEMOISE projects professional.exe...
Set Rating * Panorama Pro

Set Color Label k

Open as Smart Object in Photoshop...

Hc ShortciR R wnrd Merge to Panorama in Photoshop...

Stacking * Merge to HDR Pro in Photoshop...
Create Virtual Copy Open as Layers in Photoshop...
Metadata Presets k

Transform »

Metadata *

Export -

Email Photos...

Add to Quick Collection

Femove Photo...

Background Opticns *

7. If you still cannot find DENOISE projects professional in the Edit In list please
check if the DENOISE projects professional application is definitely set as
external editor and restart Adobe Lightroom.

15



MAC OS X

1. Open your Adobe Lightroom Application.

2. Open Preferences/External Editing.

3. Navigate to section Additional External Editor in the middle of the window.
There is no application specified as default setting.

4. Click on Choose in order to open the application folder of your MAC and to set
your external editor.

[ ] Preferences

General Presets File Handling Interface Lightroom mobile

Edit in Adobe Photoshop C55

16-bit ProPhoto RGE is the recommended chaice for best preserving
color details from Lightroom.

File Format: | TIFF

Color Space: | ProPhoto RGB

(o o o

Bit Depth: | 16 bits/component

Resolution: | 240

Compression: | ZIF

Additional External Editor

Preset: | Custom

Application: < not specified >

F L = LI LT L ¥ =L O = TS = LE= = LLG* AREC
compatible with various programs and plug-ins, but will not preserve
fine tonal detail as well as 16-bit data. The sRGE color space cannot
encompass the full range of colors available within Lightroom.

e Format: w

Color Space: | sRGE

Bit Depth: | 8 bits/component

Resolution: | 240

Stack With Original

Stack With Original

Edit Externally File Maming: IMG_0002-Bearbeitet.psd

<3 |

Template: | Custom Settings

Custom Text: Start Mumber:
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5. Navigate to the DENOISE projects professional application and click once to
highlight it. Confirm with Choose.

EO B = e 8 Applications 2 il (] Q
Favorites & Automator

23 Dropbox & Autopano Giga 2.6

. ) @l BLACK WHITE projects 4
¢ iCloud Drive @ Biu-ray Player
= Desktop T Calculator
[Z Ccalendar
12} Lektorat © Comaster
pé"; Applications <& Chess

M pocuments

Clip Browser
s COLOR projects 4

B3 akvis @ COLOR projects elements
@ COLOR proj...professional
5'“" B Contacts
desktop-giSdvng ¥4 CutOut 5.0 >
el B cutOut 5.0 professional  »
- @ Dashboard
hlehmann-pc . DEMOISE pr...professional
=1 MacDan B Dictionary
1% Dropbox
1 nas1 (AFP) & DVD Player
[ nas1 (CIFS) [ Evernote
— E2 FaceTime
onlinenas @ rirerox . .
DENOISE projects professional
@ Alle ... B Font Book
Font Browser
Tags FontsPro 2
Montag, 8. Dezember 2014 um 16:15
® Rot FontsPro 2 Promo Montag, 8. Dezember 2014 um 16:15
Orange § Game Center Dienstag, 16. Februar 2016 um 10:00
& GarageBand 117
Gelb @ Google Chrome Add Tags.
Grin @ HDR 4.0 Darkroom

@ HDR Darkroom

Cancel Choose

6. DENOISE projects professional has been set as external application now.

@ Preferences

Presets W File Handling

Edit in Adobe Photoshop €55

Interface Lightmom mobile

General

16-bit ProPhote RGE is the recommended choice for best preserving
color details from Lightroom.

File Format: | TIFF

Color Space: ; ProPhote RGE

(ol ol o

Bit Depth: | 16 bits/compenent
Resolution: | 240
Compression: _ZIP ) E

Additional External Editor

Preset: | Custom
o
Application: DENOISE projacts professional I Choose || Clear
File Format: | JPEG d JPEG files support only 8-bit. B-bit files are smaller and more
i compatible with various programs and plug-ins, but will not preserve
= fine tonal detail as well as 16-bit data. The sRGE color space cannot
Color Space: | sRGB H encompass the full range of colors available within Lightreom.

8 bits/component [

240

Bit Depth:

Resclution:

Stack With Griginal

Stack With Original

Edit Externally File Maming: IMG_0002-Bearbeitet.psd

o

USRI Custom Satfings

Custom Text: Start Number:
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7. Close that window and restart Adobe Lightroom.

8. Open an image from your Adobe Lightroom catalogue. Click on the picture while

holding down the CTRL key.

Settings
Lock to Second Window

Show in Finder
Go to Folder in Library
Go to Collection

Edit In

Set Flag
Set Rating
Set Color Label

Stacking
Create Virtual Copy

Metadata Presets
Transform

Metadata
Export

Email Photo...

¥ Add to Quick Collection and Next 4B
Remove Photo...

Background Options >

v

b A, S R e,

; P g S
Edit in Adobe Photoshop CS5...
Edit in DEMNOISE projects professional...

Analog Efex Pro 2
Color Efex Pro 3.0 Complete

Color Efex Pro &

Color Efex Pro 4

Dfine 2

Exposure 4

Piccure+

Sharpener Pro 3: RAW Presharpener
Sharpener Pro 3: OQutput Sharpener
Silver Efex Pro 2

Silver Efex Pro

Silver Efex Pro 2

Viveza 2

Viveza 2

Open as Smart Object in Photoshop...
Merge to Panorama in Photoshop...
Merge to HDR Pro in Photoshop..
Open as Layers in Photoshop...

Rk
hoc w o F3

9. Choose Edit In = Edit in DENOISE projects professional... and your photo
will be opened in DENOISE projects professional.
It will not be saved here: You can edit your image with DENOISE projects
professional and then go back to Adobe Lightroom for more adjustments
without wasting too much disc space. When you finished editing your picture
you have to save the developed photo only one time.

If you still cannot find DENOISE projects professional in the Edit In list
please check if the DENOISE projects professional application is definitely set
as external editor in the Preferences menu of Adobe Lightroom.
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1.4 Registration

Upon opening DENOISE projects professional for the first time you will be requested
to register the program. Proceed according to the following:

1. Install DENOISE projects professional as described.
2. Input the serial number. For the box version, this can be found in the accompanying

booklet. If you have the downloadable version, the serial number will have been sent to
you by email directly after the purchase.

T DENOISE projects professional

29 days remaining.

Serial Number: :] |
Please enter your serial number and dick “Activate”,

Activate now Later

3. Finally, click on the Activate now button. The software has now been successfully
activated.

Note: Using the same serial number, DENOISE projects professional can be
installed on up to two computers.

A second serial number is not necessary. For an additional installation on a different
computer, enter the serial number and then click on Activate now.
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2. Image Noise - what is it?

Image noise in digital image production occurs in many different ways.

One example is so-called low noise, a sensor-dependent noise caused by CDD and CMOS
sensors. An additional multiplier is the reading strength in digital cameras, which
produces read noise.

Hot pixels can appear with increased age of the camera or through image sensor
manufacturing defects. These are individual pixel sensors that were incorrectly
manufactured or have a significantly higher light sensitivity compared to the pixels
around them.

It generally the case, that the higher the 1ISO Number (the camera’s exposure setting) is,
the more visible the noise will be.

What types of image noise can you reduce or remove with DENOISE projects
professional?

- Chroma Noise (colour noise)
(Filter: Denoising - colour)

- Luminance Noise (bright noise)
(Filter: Denoising - HD)
- Hot pixels
(Filter: Denoising - hotpixel)
- Salt & Pepper (individual defective pixels)
(Filter: Denoising - hotpixel)
- Gaps
(Filter: Denoising - fill gaps)
- Banding
(Filter: Denoising - banding)

- Colour Clouds
(Filter: Denoising - colour clouds)

In most cases, the different types of image noise do not appear individually, but rather in
a mixed form. This is why it is important to remove noise in the correct order, as shown
above, to obtain optimal results.
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3. DENOISE projects professional — The Start Screen

[ DENOISE projects =
File Ex Extras. Information

The start screen for DENOISE projects professional is simply set up.
You can find the main menu and tool list at the top edge of the screen. This tool list
includes the following functions (from left to right):

- Image data browser

- Load image
- Stacking image sequence
- Open project

- Batch processing

- Load sample 1
- Load sample 2
- Load sample 3

Alternatively, photo files can also be dragged and dropped into the program. They will be
automatically uploaded.
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4. The Work Area

As soon as the photo file has been uploaded to the program, the virtual work area will
open.

This interface is divided into four main areas:
- Menu and tool list (top)
- Presets (left)
- Image (middle)
- Noise removal and expert mode (right)

You can remove the individual sections of the work area from the interface and place
them in other spots or on another window.

To reset the work area to its original layout, go to “View” in the main Menu and select
“Restore window defaults”.

4.1 Tool List

The tool list is divided into two sections. The left side refers to the program’s control
functions and the right tool list manages the image overview.

File Edit View Extras Information

. rﬂ Rﬂ.w % E Hf:uD% HDR. projects 3 professional - g% EE'DJ B .E| B

o h

The functions in the tool list (from left to right):
- Start (new project)
- Save current project

-  RAW-processing
- Post processing

- Save image
- Transfer image to selected projects program (Selection in the list to the right)

- Export image to external program
- Exposure bracketing and transfer to external program

- Create restore point
- Timeline

- Histogram

Certain primary functions of DENOISE projects professional will now be explained in
greater detail.
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4.1.1 Uploading and Saving Files

To load images into the program, you can either drag and drop them, use the button in
the tool list in the start menu or use “File”, “Load image”.

When importing a file into the program with drag and drop, the image data browser will
automatically open to display the folder’s contents with preview images.

A double click on the preview in the image data browser directly loads the file.

Photo formats:

DENOISE projects professional can
upload all photo formats. This also includes
camera RAW images from various
manufacturers.

If a RAW file is available, you should always
use it. This file type contains considerably
more information than, for example, a JPEG
file.

\Allfilﬂ (%" '-'I l

JPEG (*jpeg *jpg *jp2 * jif)
TIFF (*.tif *.tiff *.tif32)
Jpeg-AR (*.pr *.hdp *.wdp)
BMP (*.brmp)

PNG (*.png)

PSD (*.psd)

PCX (".px)

TARGA (*.tga)

Open EXR (*.exr)

Radiance RGBE (*.hdr)
Portable Floatmap (*.pfm)
Digital Negative (*.dng)
Canon RAW (*.cr? *.crw)
Fuji RAW (*.raf)

Hasselblad RAW (*.ff *.3fr)
Leica RAW (*.rwl)

Kodak RAW (*.kdc *.dcr)
Marniya Leaf RAW (*.iq)
Minolta RAW (*.mrw)
Mikon BAW (*.nef *.nrw *.nrf)
Olympus RAW (*.orf)
Panasonic RAW (*.rw2 *.raw *.rwl)
Pentax RAW (*.pef)

Sigma RAW (*.3f)
Samsung RAW (*.srw)
Sony RAW (*.5r2 *.srf *.arw)
Photo CD (*.pcd)

Portable Pxmap (*.ppm)]

others (*.koa *.iff *.|lbm *.pict *.pct *.pic *.5gi}
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4.1.2 Stacking Image Sequence — Noise Stacking

The stacking image sequence feature is based on the so-called Signal to Noise Ratio
(SNR).

Here a sequence of images of a subject, taken with the most similar conditions as
possible, are assembled as one image with reduced noise.

The image noise is reduced by the ration 1:“Root of the number of photos”.
For example, if you take a photo with an I1SO 12800, you can expect a high amount of
noise.

Using a tripod, consecutively take the same shot 4x and lay them one on top of the other
with image sequence stacking. You will obtain an image with 1:”the root of 4” = 1:2, i.e.
half of the original noise.

You can reduce this noise further with more photos. With 100 shots, your image at
12800 would only have 1/10 (one tenth) of the initial noise.

The following comparison is a practical example of stacking 10 images:

Single image Noise stacking with 10 images

The image sequence stacking function stacks three different types of images on the same
spot: light frames, dark frames and flat frames.

Further information on these topics can be found in the chapter 4.3.7 Correction
Images.
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4.1.3 Projects

A project includes the entire work in progress for the subject at hand. The current state
of the project can be saved (File -> Projects -> Save project), and you can return to it
and continue from this exact point at a later time.

In addition, the list of steps will be saved so that the work history can be accessed later.

4.1.4 RAW Module

The RAW module is a RAW processor integrated into the program.

Simply click on the RAW symbol in the tool list to access this function.

€ CanonEOS 1100D - 1SO 100

There are 9 different adjustment options in this module:

- White balance

- Denoising & Sharpness
- Colour Balance

- EXposure

- Detall

- Colour

- Palette

- Distortion

- General

Note: Editing is equally as possible with JPEG and TIF files.

The processing step for your image can be applied at any time and more than once in the
work history.
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An example of RAW processing from a previously loaded image can be seen here:

|4 RAW processing

% Canon EOS 11000 - ISO 100

The processing includes the following settings:

- Enhance brilliance

- Lighten shadows

- Dim brightness (more detail in sky)
- Correct distortion
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4.1.5 External Programs

There are two steps to transfer an image to an external program.

The projects Interface:
All programs in the projects product family are automatically registered. Images can be
directly transferred to the desired program using the dropdown list.

Ej HOR projects 3 professional W
PROJECTS

A transfer to HDR projects 3 professional is selected here as an example.

The Main Interface:
The main interface for external programs can be configured solely through settings
(Menu -> Extras -> Settings).

The path for external editors (General, Photoshop CC, Lightroom, Photoshop Elements)
can be configured here.

You can transfer a photo to one of the four external editors with the tool list:

Simply click on the arrow beside the transfer button and then on one of the four
programs to transfer the image.

B =
External image processing

Photoshop C56/CC

Lightroom 4/5

Photoshop Elements 11/12
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4.1.6 Undo & Timeline

An undo-restore point can be manually set at any time. This can be done using the
“Create restore point” button in the tool list or through the “Shift+Z” keyboard shortcut.

Every restore point is shown and stored in the timeline. The restore points contain all the
settings of the current project, to which you can revert to at any time.

Timeline - 4 Undo entries - 0.11 GB (33.36 GB available)

Di Dez 2 2014 - 16:47:30 Di Dez 2 2014 - 16:47:50 Di Dez 2 2014 - 16:48:39 Di Dez 2 2014 - 16:49:08

To return to a restore point, click on the button beside the respective image. The restore
point will then be recovered and automatically applied upon demand (provided changes
have been made since).

With this method, you can switch at will between your restore points and retrieve
previous steps at any time.

Furthermore, all restore points will be secured when a project is saved, so that they will
be available for future editing.

4.1.7 Batch Processing

Batch processing is accessible through “Menu -> Extras -> Batch processing”.

Once the batch processing has been activated, a window with various setting options as
well as a preview of the images located in the source folder will appear.

At the top of the screen you can choose the source folder for the batch processing and
enter the name of the destination folder, where the results should be saved. You can also
set what file type the images should be saved as.

For example, when you only want to select RAW files from the current folder, select
“Camera RAW”.

In the editing settings, you can choose if the denoising should automatically proceed (in
3 different grades of intensity) or use a fixed filter instead.
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i¥ Batch processing @
Source file Results
Source directory: sktorat\Fotos!20 dornholm ebnisse Target directory:
Format: TIF 8-Bit (*.tif)
File filter
File type: all images File name filter:
Processing settings

Image preparation: & Automatic dencising Strength balanced

Images: 48

% DsC_5301_jpo

. !

| DSC_5413_jpg

% DsC_8663 jpg

| DSC_8973_ipg

% DsC_os09_10_11_jpg

o

% DSC_0488_jpg

Adjust the selected images or start batch proc

+ ) Cancel

After you have arranged all the settings accordingly, click on the “Start” button at the
bottom right and the batch processing will remove noise from the selected images.
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4.2 Presets

Presets are located on the left side of the program’s interface and are divided into 6
different categories.

The first two categories, Noise suppression and Sharpening levels, include presets for
different ISO ranges, from ISO 50 up to 1ISO 2000000.

The JPEG, RAW, Mobile and Web categories contain specially customized denoising and
optimizing presets.

The category All simultaneously displays all of the presets and the Custom category
shows only the presets that you have made yourself.

4.2.1 Favourite System

The favourite system allows preferred presets to be marked as favourites.
To do so, click on the star beside the preset’s preview image.
Once you have selected one or more favourites, the favourite category will be activated.

With a single click on the favourite category, you are presented with all of your
favourites.

4.2.2 Import & Export

The import and export functions are used to transfer presets. These data will be saved as
.ini files.

The export button allows you to save the presently selected presets.

The import button lets you import the previously exported presets at a later time.
This way you can save your work or exchange presets with other users.

4.2.3 Search Field

You can enter any desired text you wish to search in the search field, located directly
underneath the import area. All of the presets will then be searched by name based on
the entered text and displayed accordingly.

For example, if you are looking for a preset with a soft look, simply enter soft.

A list of previously searched terms can be found to the right of the search box.
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4.3 Denoise Section (Noise Properties)

The denoise section on the right side of the program’s interface is the core of DENOISE
projects professional. Here you will find details about the noise properties, can
activate various processes, display colour channels, etc.

This topic will be introduced in detail in the following section.

Additionally, this group of functions provides the option of integrating corrective images
such as dark frames and flat frames into the current project.

A more specific explanation can be found in section 4.3.7.

MNoise properties

IS0 values for the image: Unknown

Source image noise:
Resulting image noise:

A *

ik

Colour denoising space

Bz @ ® o ¢

Display

il
Restrict area
B SN FNSsQ

Correction images
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4.3.1 1SO Display

There are three 1SO displays in the first segment of the denoise section.

The above display indicates the 1SO sensitivity of the original exposure, the example here
being at “Image I1SO Value: 1SO 1600”.

Directly below are the mathematical analyses of the image noise.
Source image noise:

Here the noise in the image will be measured by a special process and assigned an
average I1SO sensitivity, for example “Source image noise: 2.3% I1SO 400”.

The analysed image then contains 2.3% noise.

Note: Don’t be disturbed by the fact that the 1SO value of noise analysis does not match
the 1SO number of the shot. Camera sensors react differently to the set sensitivity. This
is how noise properties are distinctly distinguished between a D810 and an EOS7D Mark
1.

The image noise must be based on an analysed 1SO value, which will be displayed here.

Resulting image noise:
Directly under the source image noise you will find the analysed noise value for the result
image, in the example here “Result image noise 0.5% ISO 80”.

The 1SO value can be reduced from ISO 400 to I1SO 80 with the noise removal.

Note: Be careful not to denoise the images too much, since the natural look can be lost.
A result image noise of 0.5% to 1.0% is usually sufficient in most cases.
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4.3.2 Image Noise Measurement

Image noise is analytically determined by a process which scans and categorizes the
entire image for consistent surfaces without actual image data.

Image noise is measured in this “pure” type of noise.

Since measuring image noise throughout the entire image automatically occurs, a
manual search for potential image noise is not necessary.

A e pm

P

Balanced

Click on the “Show measured noise areas” to display this calculation section.

Note: You cannot access the automatic noise removal while the calculation window is
open. Simply deactivate the display.

4.3.3 Automatic Noise Removal and Optimization

Automatic Denoising
The automatic noise removal function analyses the current image and looks through the
denoising presets for the optimal filter.

-
s it

Balanced Grainy

Three different degrees of intensity are available with this automatic process.
The balance option will be automatically applied after loading the image.

If you want an image with a softer or grainier noise removal result, you can adjust the
automatic preset with one click on the corresponding photo.

Automatic image optimization
Once the noise removal has taken place (which automatically occurs following the initial
uploading) you can select the “Automatic denoise/optimize” button.
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One click selects the appropriate automatic noise removal optimizing filter from the
default Sharpen category.

Manual Noise Removal

Directly to the right of the automatic sharpening and optimizing is the manual noise
removal interface. Clicking this mode will temporarily deactivate the automatic system
and you receive a pre-made preset with all of the important noise removal and
sharpening effects.

You can directly edit this preset in expert mode.

4.3.4 Denoise Colour Space

The denoise colour space is a distinctive feature of DENOISE projects professional.

This colour space allows you to improve the noise removal quality of specific tones, with
reduced loss to other colours.

Colour denoising space

B E @ ® @0

There are a total of 10 different colour spaces available (from left to right):

- Colour space automatically selected based on image
- Brightness sensitivity appropriate for the human eye
- Neutral grey

-  Red dominant (e.g. rose blossom)

- Orange dominant

- Yellow dominant

- Green dominant (e.g. landscape)
- Turquoise dominant (e.g. sky)
- Blue dominant (e.g. water)

- Violet dominant

34



Let’'s look at an example of a red rose:

We see the original image on the left side with 1ISO 25600, an automatic noise removal
with the neutral grey colour space selected and the image on the right with the red
dominant colour space.

You can distinctly see the improved detail in the inside of the rose in the shot on the
right.

Note: Choose the noise removal colour space based on the area of the subject that you
want to highlight.

4.3.5 Channel Displays

The channel displays serve as the optical analysis of your image.

Display

Note: Make sure that “Real-time calculation” is active in the tool list, so that the display
will be refreshed.

There are 7 different channel displays to choose from:
(a) Full colour view
This display shows an image with all of the colour channels: red, green and blue.
(b) Luminance view

The brightness of the image (depending on the selected noise removal colour
space).
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(c) Chromatic view (Colour map view)
With the colour map view, you will very quickly see if your subject contains colour
noise. If the colours are very “unsettled”, you should use the Denoise — colour at a
high intensity.

(d) Red channel
With the red channel, you can see brightness of the red portion of the image.

(e) Green channel

With the green channel, you can see the brightness of the green portion of the
image.

) Blue channel
With the blue channel, you can see the brightness of the blue portion of the image.
(g) Difference between the source and resulting images

The difference image shows you the noise removal from the image.

Now what counts: the fewer details of the original image that can be seen in the
difference display, the better the noise removal (the fewer details of the image
were influenced).

Once the difference view has been activated, a controller will appear where you can
increase the contrast of the difference display. For images with minimal image
noise, the difference is difficult to notice — in this case, simply increase the
difference contrast.

A comparison of the different views of the image clarifies the functions.

Original image — Luminance view — Chromatic view

It is clear to see the distinct noise in the chromatic view on the right side, which indicates
colour noise.

Note: Activate the measurement field to also display the colour noise as a numerical
value, here 30.8% colour noise.
The brightness noise in the luminance view in the middle is significantly less noticeable.
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Red channel — Green channel — Blue channel

The comparison of the noise properties in the colour channels provides important
information for choosing the correct noise removal colour space.

In this section, prominent noise can be seen in the red and blue channels. The green
ratio contains relatively little noise.

Putting this information together indicates that a purple colour space should be applied
for the intense red and blue noise.

Note: What colour space should I use for which colour channel noise combinations?

Red & Green = yellow colour space noise removal
Red & Blue = purple colour space noise removal
Green & Blue = turquoise colour space noise removal

Original image — Denoised image — Difference view

The view of the light noise around the string of lights in the denoising view (here with a
difference contrast of 150%, i.e. enhanced) shows that practically only noise was
removed from the image.

This can be confirmed by the fact that basically no details can be seen in the difference
view.
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4.3.6 Restricting Areas

Area restriction allows you to limit the noise reduction to a specific area.

Restrict area

H &8N )

In this case, there is a more obvious direct comparison between the original image and
the result after noise removal.

150 DENOISE projects professional (64-bit) - VI 1702351 - *C./Program Files/F i i i [of @ s
Fie Ean

Also, you can save valuable time by restricting areas in the manual noise removal
setting. The smaller the noise reduction area, the faster the calculation.

If you are satisfied with the results, reactivate the denoising for the entire image.
The 8 restriction modes (from left to right):

- Full image (entire image)

- Diamond

- Elliptical

- Rectangle

- Left side

- Right side

- Horizontal middle
- Vertical middle

38



Once area restrictions have been activated, a controller will appear where the size of the
area can be regulated.

frez sme 100

4.3.7 Correction Images Correcton images

The correction image option offers you the
opportunity to remove noise in a professional
manner with the help of correction images.

Compared to classical mathematical noise

removal, this method is an exact procedure. Theeshold vehue
DENOISE projects professional Correction radius
fundamentally supports the application of so- -

called dark frames and light frames.
Colour correction 50

Flat frame strength 50

The individual correction image buttons:

The buttons are divided into three categories.

In the middle there is the “Upload a correction image” function. This button is active until
two images have been uploaded. The software automatically recognizes if the uploaded
file is a dark or light frame.

To the right there are 3 buttons (from left to right):
- Delete the currently loaded dark frame
- Activate the dark frame absorption
- Show the current dark frame
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On the right hand side are the same 3 buttons but for controlling light frames.

Dark frames — what are they?

A dark frame is a shot of sensor noise from a covered sensor. To shoot a dark frame,
cover the lens with an opaque object, or alternatively use the lens cap, and take a photo
of the dark noise.

It is important to use the same settings (exposure and operating temperature) when

taking a dark frame — ideally, take the normally lit photo and immediately after a dark
frame, so that the camera’s temperature doesn’t change too much.

Original image — Dark frame — Calibrated image

On the left we see the original image that is disturbed by the sensor’s dark noise.

The dark frame is in the middle, that is, the dark noise. The prominent interface is easily
recognizable by the lighter pixels, which are also easily seen in the original image. This
disturbance is usually caused by a sensor micro defect.

The picture on the right is the corrected (calibrated) image, with help from the dark
frame.

There are 4 parameters for dark frame correction settings:

(a) Iteration

Iteration shows the number of cycles of the dark frame correction algorithms. These
correction processes work very accurately. A high iteration value improves the precision
but probably generates a softer result.

(b) Threshold

The threshold determines the minimum brightness of the dark frame, so that a correction
for the respective pixel can occur.

(c)Correction radius
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Use the correction radius to select the pixel area in which the correction should take
place.

A radius of 1 uses an area of 1 pixel, so in total 3x3 pixels, a radius generates a
correction matrix of 7x7 pixels.

(d) Colour correction

Colour correction is option for reducing so-called colour clouds. Colour clouds are very
soft and widespread colour noise.

Note: Often in astrophotography many dark frame shots will be taken, which are then
summed up into a “Master dark”. Definitely 50, if not more, dark frame shots can be
taken to be assembled into the master dark.

The rule of thumb is that more dark frames than normally exposed shots should be
taken, so that the noise in the master dark is less than that in the master light.

DENOISE projects professional can directly assemble the sequence of dark frames for
you with the batch processing function.

Flat Frames — and what are they?

Flat frames are exposures of a uniform surface showing sensor spots and vignetting. It is
thereby important to take the flat frames with the same optic settings (filter, lens etc.)
as the shots of the actual subject.

The flat frames will help to remove light distortions like the camera’s vignetting and
caught dust (sensor spots).

It is also practice, like with dark frames, to take many shots that can then be assembled
into a “master flat”.

The “stacking image sequence” function has a special modus for flat frames, just like it
does for dark frames.

In the original image on the left, a light interference can be seen in the upper left half.

The middle image is the flat frame (master flat) — which also clearly shows the
shadowing defect in the brightness.
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On the right side we have the flat frame calibrated result. The disturbance has been
completely removed.

The flat frame correction settings have one parameter:
(a) Flat frame intensity

The flat frame intensity enables you to readjust the flat frame correction, if it should
appear to be too weak.

Note: Flat frames must also be applied against dark frames. DENOISE projects
professional automatically attends to this for you in the background.
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4.4 Astrophotography

The following example is meant to B
optically familiarize you with this
program’s capabilities — Galaxy M31 —
Andromeda.

Many thanks to Markus Janes for
granting permission to use this astro
photo series.

The top picture shows a single shot and
the bottom photo shows the entire result
as edited by DENOISE projects
professional.

And here is the effort behind it: e
20 images each with a 5 minute =
exposure assembled into the “master
light”

20 dark frames assembled into a
“master dark”

30 flat frames assembled into a “master |
flat”

The Process:

Stack the dark frames with the “Stacking image sequence” function to generate the
master dark.

Stack the flat frames with the “Stacking image sequence” function to generate the
master flat.

Stack the light frames with the “Stacking image sequence” function to generate the
actual image of the subject — this shot (master light) is the one that you upload into the
program yourself.

Now load both correction images (master dark and master flat) and activate the dark as
well as flat frame applications.

You can then carry out the fine tuning in expert mode.
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4.5 Scratch & Sensor Spot Correction
Scratch and sensor spot correction can be found on the right hand side in the “Finalise”
window, down at the bottom, with good reason. A scratch and sensor spot correction
should always be the last task to be performed.

As soon as the correction has been activated, a new window will open:

ucmnmemm E

The work area is in the middle and the settings can be adjusted on the right side.

At the very top of the right hand column are the preview settings, starting with the radar
view. You can zoom in and out as well as move the image in this display.

Beneath the radar is the contrast view, which aids in finding irregularities in the image.

Activate the contrast view with the button on the left and adjust the intensity of the view
with the control beside it to the right.

Both of these buttons respectively activate and deactivate displaying corrective areas
(left) as well as the correction area targets (right).
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The two buttons in the section below effect the complete correction area.

The left button calculates a new optimal correction spot based on all of the correction
areas. The right button deletes all current correction areas, which requires a security
confirmation.

Correction areas ( 0/200
The bottom settings block contains the ¢ "II ]
actual values of the correction areas:

As you can see in the above image, 14 of
200 correction areas are set here.

To select another area, click on the brush,
set the desired size with the control beside it
on the right and click on the portion of the
image that you would like to correct.

The correction target area will then be
automatically found, accordingly placed and
displayed to you.

You can shift this target area with your
mouse if you are not content with the
automatic proposal.

The “Size” control under this section enables modification of correction area. Simply click
on the correction area and adjust the size with the controller.

The bottom left button allows you to switch the currently selected correction area back to
the automatic mode, as long as you have modified the area.

With the bottom right button, you can delete the currently active correction area.

The keyboard configuration for this window can be found in chapter 5 Keyboard and
Mouse Shortcuts.
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4.6 Expert Mode

Expert mode serves to fine tune your images. After
you have found an automatic noise removal
setting, you can adjust all details in expert mode.

4.6.1 Magnifying Glass

The magnifying glass shows you a 1:1 comparison
between the original and edited images. Hold your
cursor over any desired point on the image. You
can fix the magnification with the “L” key (Lock) to
monitor a specific area while editing it.

When the area is fixed, a white dotted line will
appear around the edge of the magnifying glass.

4.6.2 Post-Processing Effects

The list of available post processing effects (filters)
includes all of the tools used to assemble the
presets.

Different types of effects can be found here:

- Edge effects
Denoise, sharpen, erode, dilate...
- Exposure effects
Gradation curve, brightness,
gamma correction, vignetting...
- Colour effects
Colour intensity, colour balance, chromatic
aberrations, manual white balance...
- Soft focus effects
Smooth colour tone, soft focus

contrast,

The so called context menu can be opened with a
right click. Here you can disable individual effect
groups to get a better overview of the effect of a
singular category.

The most important effects for denoising your
images are with the edge effects, notably all
effects beginning with “Denoise -” here. (An exact
overview can be found in Chapter 2.)

If you want to add a post processing effect to
those of the current filter, double click on the list
entry and the effect will be automatically added to
the end of the “Effects you have selected” section.

46

Expert mode: 150 125

finalize expert

- 'i '::I'\

4 Post-processing filter (43/43)

Denoise - smoothing

g - banding

lour

g ur clouds

g - fill gaps

g - HD iterative

g - HD ultra
Denoising - smooth surfaces
Dilate
Dithering - Floyd-5teinberg

AoIse SUpEr

Luminance sharpening (H)

Effects you have selected (4/6)
¢ B Denoising - colour
1 ol 30 ion HD
uppression
voth surfaces

Denoising - colour

normal

Intensity 200

Complete




4.6.3 Effects You Have Selected

The list of effects you have selected represents BifSsepi il s Sai keIl
the entire calculation process for the current

- .r}g:- _ P _
image. ¥ I Denoising - colour

% M MNoise suppression HD

The effects can be turned on and off by % W Hot | noise suppression

selecting the check marks beside the names. % M Denoising - smooth surfaces
J . Denoising - banding

A small icon to the right of the checkmark =

shows you if a layer effect (light bulb) or

selective editing (red-green circle) is active.

. Denoising - colour clouds

If you have an effect that you would like to have at a different position in the order of
edits, simply use the mouse to pick it up and slide it to the desired place. The result will
be automatically refreshed.

Note: The order of the effects has a crucial influence on the results, depending on the
combination. If you want to reduce the chromatic aberration for example, you should
always do so before enhancing colour intensity. By boosting the colours first, the
aberration will also be amplified.

A right click on the effects you have selected menu will open a context menu with the
following functions:

- Activate effect

- Activate all effects

- Activate all other effects
- Activate this effect only
- Deactivate all effects

- Duplicate effect

- Restore effect

- Send to top of list

- Send to end of list

- Delete effect

-  Remove all the effects

As soon as you have selected an effect in this field, the settings for the effect at hand will
appear directly below this area.

4.6.4 Parameters — Layer Methods

At the very beginning of the parameter section for the selected effect (here Denoise —
colour) is the tool to set the calculation method for this effect layer.

Denoising - colour

normal
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The calculation method for this effect layer can be chosen in the dropdown menu.
Numerous variations are available here, starting with simple methods like brighten and
darken to colour burning and linear dodging.

Note: Feel free to try out these techniques — the layer calculations can be restored back
to normal at any time when you deactivate them.

On the right side, the opacity of the effect layer can also be adjusted.
If an effect is too strong for you, you can reduce the opacity some until you are pleased
with the result.

4.6.5 Parameters — Selective Editing

Underneath the layer calculations are the buttons for selective editing.

From left to right:

Open selective editing
- Copy selective areas to the clipboard

- Copy selective areas from the clipboard into the currently selected effect (existing
areas will then be replaced)

- Delete all selective areas from the selected effects

Selective areas present a special feature. You can set up to 32 selective layers for every
effect layer.

Selective areas can be either positive (green) or negative (red), and you can be mixed
according to your preference.

What establishes a positive selective area?
A positive area allows you to specify an area of the effect layer to be modified while the
rest of the image remains unaffected.

And what establishes a negative selective area?
Negative selective areas do the exact opposite. This effect excludes selected areas from
the current effect layer.

A new window will open once the selective editing has been activated. Here you can fix
the selective area for the chosen effect layer (here colour intensity).
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|8 selective editing =
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The below tool list enables the creation of areas and the generation of masks using these
areas.

The individual functions are (from left to right):

- Add positive selective area
- Add negative selective area

- Inverts the selective areas (positive becomes negative and vice versa)
- Duplicate currently selected area

- Delete currently selected area

- Invert all selective areas

- Deactivate the display of selective areas

- Show only the selected selective areas

- Show all selective areas

- Select next selective area
- Select the previous selective area

In the example image we see a positive selective area over the top of the tree for the
colour intensity effect.

The area can be shaped however you like. Grab the marked edge of the area with your
mouse and move the area’s borders into your preferred form.
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To move the entire area, simply grab the depicted right corner and move the area to
where you want it.

Once a selective area has been selected, the three controls on the top edge of the
window will be activated, giving you with additional influence on the image.

Strength

Curvature:
Adjust the curvature of the selected area from a hash (controller to the left) to a
rectangle (controller to the right).

Sharpness (edge definition):

Adjust the edge definition of the selective area from soft (controller to the left) to sharp
(controller to the right). If you want to mask a window, for example, select
curvature=100% and edge definition=100%

Strength:
The intensity sets the opacity of the selective area at hand. This way you can somewhat

reduce the effect.

When you are finished setting the selective areas, click “Exit”. The adjustments will be
applied and the results refreshed.
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4.6.6 Parameters — Set Values

There are different types of data that
you can modify within the parameters
of an effect layer.

The “Intensity” control parameter can
be seen here as an example.

You can either directly adjust the
control parameter with the controller
or by inputting a numerical value.

Double clicking the controller’s handle
will always reset the conditions back to
their standard values.

Directly below the controller is a
masking curve with a few presets
above the displayed curve.

You can automatically create
brightness masking with the masking
curve. Move the control points on the
brightness curve to your preferred
levels. The top edge has a 100% effect
intensity while the bottom edge has a
0% effect intensity.

You can see a real time display of the
curve’s masking while moving the
control points. The effect shows a high
intensity in bright areas and a lesser
intensity in darker areas.
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5. Keyboard and Mouse Shortcuts

General Functions

| Function Windows | Mac OS
New project CTRL + N CMD + N
Upload image CTRL + SHIFT + O | CMD + SHIFT + O
Save result image CTRL + S CMD + S

| Lock magnifying glass L | L

| RAW processing F4 | F4
Show histogram CTRL + H CMD + H
EXIF information CTRL + E CMD + E
Full screen view CTRL + F CMD + F

Quit full screen view

CTRL + F/ ESC

CMD + F / ESC

Call up home page @ @
Help F1 F1
About DENOISE projects professional SHIFT + F1 SHIFT + F1
Stacking CTRL + B CMD + B
Settings CTRL + P CMD + P
Timeline on/off CTRL+T CMD + T
Save project SHIFT + Z SHIFT + Z

Image to fit

Double click

Double click

Image to fit 1:1 view

Double click again

Double click again

Quick comparison Right click Right click
Selective Editing

| Function Windows Mac OS

| Move selected area Arrow keys Arrow keys
Select previous field Image up Image up
Select next field Image down Image down
Delete current Delete Delete
Deactivate mask display 1 1
Display selected mask areas 2 2
Display all mask areas 3 3

52




Screen & Sensor Spot Correction

| Function Windows Mac OS
Move selected correction area Arrow keys Arrow keys
Enlarge selected correction area + +
Reduce selected correction area - -
Select previous Image up Image up
Select next Image down Image down
Delete current Delete Delete
Set new correction area N N
Activate all correction areas C C
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Support

If you have questions regarding the installation, problems or errors of the software, please
contact the FRANZIS customer support team.

Contact form: www.projects-software.com/Zcontact

Please understand that your questions can only be answered directly by FRANZIS customer
support. This is to give us the opportunity to constantly enhance our customer service for you
and to make sure that you receive only the most qualified answers to all of your questions as fast
as possible.

This is how our customer support works best:
Please have the most important details about your computer and about our product at hand when
you call our customer support. These include:

¢ Name of the product

e Product ISBN (which you can find on the back of the packaging, above the easy to spot
barcode).

¢ Operating system of your computer

¢ Technical details of your PC including all your peripheral devices

Copyright

Franzis Verlag GmbH has prepared this product with the greatest possible care. Please read the
following conditions:

All the programs, routines, controls, etc., contained in this data media or within this download
are protected by their respective authors or distributors as mentioned in the respective
programs. The purchaser of this data media or of this download is authorised to use those
programs, data or data groups that are not marked as shareware or public domain for his/her
own purposes within the provisions of their designated use. He/she is authorised to use programs
or parts of programs that are marked as shareware, freeware or public domain within the
restrictions given by the respective programs or parts of programs. A reproduction of programs
with the intent of distributing data media containing programs is forbidden. Franzis Verlag GmbH
holds the copyright for the selection, arrangement and disposition of the programs and data on
these data media or these downloads.

The data and the programs in this data media or within this download have been checked with
the greatest possible care. Considering the large quantity of data and programs, Franzis assumes
no warranty for the correctness of the data and a flawless functioning of the programs. Franzis
Verlag GmbH and the respective distributors do not undertake neither warranty nor legal
responsibility for the use of individual files and information with respect to their economic viability
or their fault-free operation for a particular purpose.

Additionally, there is no guarantee that all the included data, programs, icons, sounds and other
files are free to use. Therefore the publisher cannot be held liable for a possible breach of third
party copyrights or other rights.

Most product designations of hard- and software and company names and labels mentioned in
this product are registered trademarks and should be treated as such. The product designations
used by the publisher are basically as the manufacturer describes them.

© 2016 Franzis Verlag GmbH, Richard-Reitzner-Allee 2, 85540 Haar, Miinchen
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